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EBS & MAED 
Hands-on 2: EBS Mauritius Case Study 

Learning outcomes 

By the end of this exercise, you will be able to:  

1) Use an official Energy Statistics publication to compile basic energy statistics in EBS 

2) Identify energy forms and energy flows (from primary energy requirements) 

3) Identify appropriate data and input them into EBS 

4) Produce an Energy Balance 

Preparation 
To complete this exercise, you must have available: 

• EBS 
• the Mauritius Demo Case – empty.ebsz 
• the pdf “Mauritius Energy Statistics” 

Download the Demo Case and Energy Statistics from the following link: 

https://zenodo.org/records/14975551 

The objective of this exercise is to use real data on energy production, import/export, and 
consumption to demonstrate use of the EBS tool for energy balance compilation. To do this, we 
will conduct a real case example, based on the annual Digest of Energy and Water Statistics 
published by the Central Statistics Office of the Ministry of Finance and Economic Empowerment 
of the Republic of Mauritius.  

We will use 2008 data because there are fewer fuels to enter compared to the more recent 
balances. 

In this exercise the publication is used to compile basic energy statistics using EBS and check 
whether energy balance corresponds to the published energy balance. The United Nations 
Statistical Division questionnaire is referred to at points throughout this hands-on exercise as the 
UNSD questionnaire.  

https://zenodo.org/records/14975551
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The steps are as follows:  

• Check the different sections in the energy section of the publication 
o Energy Balance (to be used for checking our results at the end of the exercise) 
o Primary energy requirements 
o Transformation of energy 
o Final energy consumption 

• Identify energy forms and energy flows (from primary energy requirements) 
• Use specific energy coefficients (if available) 
• Identify appropriate data and input them into EBS 
• Check the energy balance (i.e., compare EBS results to the publication) 
• Save your work 

Open the empty case study 
For the exercise, again go to “File” and click “Open”. Change “Files of type” to “EBS Country 
Package File”. 
Select: Mauritius Demo Case – empty.ebsz 
Press “Open” 

 

EBS is laid out as follows:  

The Country name is in the top bar 
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The Upper part of the screen shows the list of fuels organized by: 

• Fuel ID 
• Fuel Name 
• Unit (standard metric unit) 
• Standard Conversion Factor 

 

You may hide fuels that are not of interest to your country.  
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Energy flows for selected fuels are visible on the left of the screen. Each fuel has an ID consisting of 
fuel ID and row number.  

 

The right side of the screen shows editable cells, with one column for each year. Cells in green can 
be edited, those in yellow are calculated.  
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The lower part of the screen shows the fuel description. On the right side there is a field to provide 
notes as needed.  

 

Note that some energy forms are not available in the list (e.g., wind, solar) – this will be explained 
later.  

Note that fuel names may differ from the Standard International Energy Product Classification 
(SIEC) names.  

Note that the years you will see on your screen will differ. 

 

Before you start, you must organize your workspace by hiding unused energy forms. 

In order to hide unused energy forms, it is possible to use "hide" checkbox and "revert" selection 
from the View menu, as follows. 
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Hide used energy forms: 

 

 

Revert selection from View menu: 
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Activate filter from View menu  
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How to enter data 

All inputs into questionnaire should be in natural units. To input the data, you must:  

1. Select the appropriate fuel under Questionnaire view.  
2. Provide specific conversion data if available.  
3. Enter data for different energy flows.  
4. Repeat these actions for all fuels. 
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Edit specific conversions where data are available.  

 



 
 

CCG 2021                                                                                                                                      Page | 10  
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After editing specific conversion factors, you should save the case.  
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Each time you want to save the case, the option to provide case name will appear. You will have to 
select from the list of cases and confirm by pressing "Save". 

The model will not warn you if you have by mistake selected the wrong case name, so pay 
attention.  

It is advisable to select ".ebsz" file type, especially if specific conversion factors are provided. 
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In this case study, the following must be considered for certain fuel types.  

Coal 

For coal, the natural unit is thousands of metric tons. Coal is imported; therefore, it is assumed it 
belongs to Hard Coal type. (High calorific coals are traded internationally, while low calorific coals 
such as lignite are usually extracted and consumed locally) 

The specific conversion factor for coal is on p. 12 of the Mauritius Energy Statistics 
• 0.62 toe/ton; this value must be recalculated to have the units TJ/thousand tons 
• 1 toe = 0.041868 TJ 
• 1000 ton = 1000 * 0.62 toe = 620 * 0.041868 TJ = 25.95816 TJ 
• Therefore, the specific conversion factor is 25.95816 TJ/thousand ton 

Imports – p. 26, Table 2.2 

• Value for 2008 is 606.5 [thousand tons] 
• Value to be entered into row CL03 

Use for electricity generation – p. 39, Table 3.7 

• Value for 2008 is 609.745 [thousand tons] 
• Value to be entered into row CL088 

Use in final consumption – p. 43, Table 4.3 

• Used in Manufacturing (Industry) 
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• Value for 2008 is 41.672 [thousand tons] 

Value to be entered into row CL1214 

Independent Data Input 
For all subsequent energy forms, you need to enter data independently. Try to research and 
understand the publication. 

Wood 

This is a locally produced energy form. The specific conversion factor is on p. 12 of the Mauritius 
Energy Statistics. 

• 1 ton = 0.38 toe (tons of oil equivalent) 
• For use in EBS (i.e. in UNSD questionnaire), it must be recalculated into TJ. 
• 1 toe = 0.041868 TJ 
• 1000 tons = 1000 * 0.38 toe = 380 * 0.041868 TJ = 15.90984 TJ 
• Therefore, the specific conversion factor is 15.90984 TJ/thousand tons 

Production – p. 24, Table 2.1 

• Production is given in thousand tons, while in the UNSD questionnaire the required unit is 
cubic meters [m3] 

• For the time being, the assumption is that we provide data in thousand tons and the 
specific conversion factor in TJ/thousand ton (the final calculation of the energy balance 
will be correct as the conversion factor is also adjusted) 

• Fuel wood production has to be entered in row FW01 – value 20.8 thousand tons 

Final consumption – p. 43, Table 4.3 

• Fuel wood is used in industry (it is not specified in which industry). Industrial consumption 
is therefore entered into FW1214, value 1.425 thousand tons 

• Fuel wood is used in household sector. Household consumption is therefore entered into 
FW1231, value 16.726 thousand tons 

Bagasse 

Domestic primary fuel. Bagasse is a by-product of sugar production, but it is treated as a primary 
energy form. 

The specific conversion factor is on p. 12 of the Mauritius Energy Statistics. 
• 1 ton = 0.16 toe (tons of oil equivalent) 
• For use in EBS (i.e. in UNSD questionnaire), it has to be recalculated into TJ 
• 1 toe = 0.041868 TJ 
• 1000 tons = 1000 * 0.16 toe = 160 * 0.041868 TJ = 6.699 TJ 
• Therefore, the specific conversion factor is 6.699 TJ/thousand tons 
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Production 

• p. 24, Table 2.1 (values are estimated) – Row BS01 – value 1540.2 
• p. 39, Table 3.7 –IPP (sugar factory) – Row BS088 – value 1300.939 thousand tons 

Final consumption 

• p. 43, Table 4.3 – only in industry 

Note, it is not clear for which purposes it is used in industry. 

 

Charcoal (Secondary) 

Charcoal is secondary (transformed) energy form and can be produced locally (from fuel wood) or 
it can be imported. 

There are no data on import of charcoal (p. 26, Table 2.2). 

Transformation of energy – there are no data on charcoal production (i.e., no data on 
transformation of fuel wood to charcoal). 

Energy balance (p. 19, Table 1.1) shows transformation data – fuel wood in Other transformation – 
(822) toe and respective production of charcoal – 400 toe. 

The specific conversion factor is on p. 12 of the Mauritius Energy Statistics. 
• 1 ton = 0.74 toe (tons of oil equivalent) 
• For use in EBS (i.e. in UNSD questionnaire), it has to be recalculated into TJ 
• 1 toe = 0.041868 TJ 
• 1000 tons = 1000 * 0.74 toe = 740 * 0.041868 TJ = 30.98 TJ 
• Therefore, the specific conversion factor is 30.98 TJ/thousand tons 

According to the energy balance table, it was assumed that production is equal to consumption 
(consumption data most probably estimated) and statistical difference is zero. 

• Therefore, there is a need to assess consumption of fuel wood for charcoal production and 
charcoal production. 

• For our demo case we assume the same: availability (in this case assumption is that 
charcoal is imported) equals consumption – Row CH01 – value 0.543 thousand tons. 

Final consumption 

• p. 43, Table 4.3 – commercial sector – Row CH1234 (other)– value 0.422 thousand tons; 
• residential (household) sector – Row CH1231 – value 0.119 thousand tones 

 

Motor Gasoline 

The assumption is that gasoline is motor gasoline according to the UNSD questionnaire. 
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The specific conversion factor is on p. 12 of the Mauritius Energy Statistics. 
• 1 ton = 1.08 toe (tons of oil equivalent) 
• For use in EBS (i.e. in UNSD questionnaire), it has to be recalculated into TJ 
• 1 toe = 0.041868 TJ 
• 1000 tons = 1000 * 1.08 toe = 1080 * 0.041868 TJ = 45.22 TJ 
• Therefore, specific conversion factor is 45.22 TJ/thousand tons 

There is no data on stock changes. 

No export. It is an imported fuel: 

• p. 26, Table 2.2 – Row MO03 – value 108.5 thousand tons  

Final consumption: 

• p. 43, Table 4.3 (transport only, assume road) – Row MO1221 - value 101.406 thousand tons 

 

Dual Purpose Kerosene (S) – Jet fuel 

The assumption is that it is kerosene-type jet fuel (JF) and other kerosene (KR) according to the 
UNSD questionnaire. Jet fuel is used for aircrafts, kerosene mainly for households  

The specific conversion factor is on p. 12 of the Mauritius Energy Statistics. 
• 1 ton = 1.04 toe (tons of oil equivalent) 
• For use in EBS (i.e. in UNSD questionnaire), it has to be recalculated into TJ 
• 1 toe = 0.041868 TJ 
• 1000 tons = 1000 * 1.04 toe = 1040 * 0.041868 TJ = 43.54 TJ 
• Therefore, the specific conversion factor is 43.54 TJ/thousand tons 

Imported fuel: 

• p. 26, Table 2.2 – Row JF03 – value 262.2 thousand tons 

No data on stock changes. 

International bunkers: 

• p. 29, Table 2.6 – re-export to international (aviation) bunkers – Row JF052 – value 125.5 
thousand tons 

Final consumption: 

• p. 43, Table 4.3 (domestic aviation) – Row JF1223 – value 131.631 thousand tons 

 

Dual Purpose Kerosene (S) – Kerosene 

Imported fuel. 



 
 

CCG 2021                                                                                                                                      Page | 18  

Specific conversion factor (the same as for Jet Fuel) – p. 12 

Import 

• p. 26, Table 2.2 – Row KR03 – value 5.9 thousand tons 

No export. 

No stock changes. 

Transformation: 

• For electricity generation (transformation in electricity) – p. 39, Table 3.7 – Row KR088 – 
value 2.059 thousand tons 

Final consumption:  

• In households – p. 43, Table 4.3 – Row KR1231 – value 1.772 thousand tons 

 

Diesel 

Gas diesel in UNSD Questionnaire. Imported fuel. 

The specific conversion factor is on p. 12 of the Mauritius Energy Statistics.  
• 1 ton = 1.01 toe (tons of oil equivalent) 
• For use in EBS (i.e. in UNSD questionnaire), it has to be recalculated into TJ 
• 1 toe = 0.041868 TJ 
• 1000 tons = 1000 * 1.01 toe = 1010 * 0.041868 TJ = 42.29 TJ 
• Therefore, the specific conversion factor is 42.29 TJ/thousand tons 

Import: 

• p. 26, Table 2.2 – Row DL03– value 328.5 thousand tons 

International (marine) bunkers: 

• p. 29, Table 2.6 – Row DL051 – value 117.3 thousand tons 

Transformation: 

• Electricity generation (transformation), p. 39, Table 37 (both islands) – Row DL088 – value 
1.580 thousand tons 

Final consumption (p. 43, Table 4.3) 

• Industry – Row DL124 – value 46.301 thousand tons 
• Transport (not indicated mode of transport – assume road, but can be also boats) – Row 

DL1221 – value 152.910 thousand tons 
• Agriculture – p. 43, Table 4.3 – Row DL1232 – value 2.241 thousand tons 
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Fuel Oil (Secondary) 

Residual fuel oil (RF) in UNSD Questionnaire. Imported fuel. 

The specific conversion factor is on p. 12 of the Mauritius Energy Statistics. 
• 1 ton = 0.96 toe (tons of oil equivalent) 
• For use in EBS (i.e. in UNSD questionnaire), it has to be recalculated into TJ 
• 1 toe = 0.041868 TJ 
• 1000 tons = 1000 * 0.96 toe = 960 * 0.041868 TJ = 40.2 TJ 
• Therefore, specific conversion factor is 40.2 TJ/thousand tons 

Import: 

• p. 26, Table 2.2 – Row RF03 – value 291.0 thousand tons 

International (marine) bunkers: 

• p. 29, Table 2.6 – Row RF051 – value 96.2 thousand tons 

Transformation: 

• Electricity generation – p. 39, Table 3.7 (for both islands) – Row RF088 – value 167.547 
thousand tons 

Final consumption: 

• Industry, p. 43, Table 4.3 – Row RF1214– value 54.639 thousand tons 

 

LPG (Secondary) 

Imported fuel 

The specific conversion factor is on p. 12 of the Mauritius Energy Statistics. 
• 1 ton = 1.08 toe (tons of oil equivalent) 
• For use in EBS (i.e. in UNSD questionnaire), it has to be recalculated into TJ 
• 1 toe = 0.041868 TJ 
• 1000 tons = 1000 * 1.08 toe = 1080 * 0.041868 TJ = 45.22 TJ 
• Therefore, the specific conversion factor is 45.22 TJ/thousand tons 

No stock changes 

Import 

• p. 26, Table 2.2 – Row LP03 – value 63.1 thousand tons 

Final consumption (p. 43, Table 4.3) 

• Industry (other) – Row LP1214 – value 4.92 thousand tons 
• Transport (assuming road) – Row LP1221 – value 5.184 thousand tons 
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• Commercial – Row LP1235 – value 10.094 thousand tons 
• Residential – Row LP1231 – value 42.394 thousand tons 

 

Hydro and Wind (Primary) 

In the UNSD Questionnaire there is a separate part for electricity. Here, generation must be given 
by primary type of production (public, auto-producers…). The unit in the questionnaire is million 
kWh (i.e. GWh). 

Hydro and wind are used to produce electricity; therefore, they appear in commodity balances as 
domestic electricity production. 

On p. 24, Table 2.1 – electricity production is given in GWh. 

On p. 36, Table 3.3 – electricity production is given by primary source, location, and company 
(two islands, public, IPP…) 

Hydro and wind are under CEB (the national electricity company) and the assumption is that those 
are public generation plants. 

Hydro generation should be entered under electricity (EL), row EL015HY – value 108.0 GWh 

Wind generation should be entered under electricity (EL), row EL015W – value 0.4 GWh 

 

Electricity 

Under the electricity form in the questionnaire only one thermal category exists. Therefore, all 
thermal power generation must be included as thermal power plants. 

The national electricity company is CEB. IPPs produce electricity and sell it to CEB, and part of it is 
consumed for their own uses (i.e., in this case in sugar factories). Therefore, this generation is 
placed under auto-producers 

• –Row ET015C – value 833.7 GWh 
• –Row ET016C – value 1615.1 GWh 

There are values for losses and energy sector own use/consumption in the energy balance (p. 19, 
Table 1.1, electricity losses are 18.545 ktoe), but not in the rest of the document. There are some 
data on other consumption and losses (p. 44, Table 4.4) but with no indication of the fuel type. 

The electricity sector’s own use is also visible only in the energy balance (p. 19, Table 1.1, own use is 
3.263 ktoe) and in Table 4.8 there is one part of consumption assigned to CEB (the electricity 
company). 

On p. 48, Table 4.7 there are data on sale to consumers. The same table shows data on electricity 
sale to industrial consumers which are "different" from the previously given final consumption 
(probably because of auto-producers) 
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Electricity consumption – p 48. Table 4.7 (On p. 50, Table 4.8 indicates further division of sales by 
consumer) 

• Domestic – Row EL1231, value 652.2 GWh 
• Commercial – Row EL1235, value 672.7 GWh 
• Other – Row EL1234, value 40.0 GWh 
• Industry 

• The assumption is that the difference between IPP generation and sale to CEB is 
consumed in the sugar factories (industrial consumption) – value 250 GWh (other 
industry). 

• Industry reported in Table 4.7 is added, so Row EL1214 is 250+688.7 GWh = 938.7 GWh 

Note that plants’ own consumption is not reported (therefore we cannot fill it in). As this row is 
calculated in EBS (row EL0927), we enter a value for the net production to have self-consumption 
of 0. 

• Net Production – EL019, value 2557.2 

 

Checking the results 
At this point the energy balance studio outputs can be compared to those of the Mauritius Energy 
Statistics.  

It is possible to change the units if needed.  

 

 

Once you have checked the results, you may wish to export them. Click File > Export or Export all. 
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